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Overview 
Welcome to Deltek Cobra 8.4 Release Notes. These release notes contain a summary of the following: 

 New Features and Enhancements 

 Software Issues Resolved 

 Database Changes 

Viewing the Online Help 
If you use Internet Explorer and the online help does not display correctly, you need to turn off 
Compatibility View for the browser. Click Tools » Compatibility View settings, and clear the Display 
intranet sites in Compatibility View check box. Then refresh the browser. Make sure you remove 
deltek.com (if listed) from the Websites you have added to Compatibility View list. You could also elect 
to use hosted help or the FQDN of your server in the URL (for example, server.domain) to bypass this 
issue. The Cobra 8.4 Help System URL is https://help.deltek.com/Product/Cobra/8.4/GA. 

Depending on your Internet Explorer security settings, you may be prompted to “Allow blocked content” 
when viewing the Cobra Online Help locally. This only affects Internet Explorer.  

You may also access the online help using Edge, Chrome, and Firefox. 

Integration with PM Compass 
If you have upgraded from one version of Cobra to another and are using PM Compass, ensure that you 
install the most recent version of the Cobra Integration for PM Compass file that was released prior to or 
at the same time as the PM Compass Cumulative Update that you are using on your PM Compass 
server. 

To further explain this scenario, refer to the following table, which summarizes the Cobra 8.5 Integration 
for PM Compass files released for PM Compass 8.4 Cumulative Updates. 

PM Compass 8.4 Cumulative Update (CU) Cobra 8.5 for PM Compass 8.4 Integration File 

PM Compass 8.4 CU 05 No new integration file 

PM Compass 8.4 CU 04 No new integration file 

PM Compass 8.4 CU 03 Deltek Cobra 8.5 Integration for PM Compass 
8.4_8.5.0704.3469 

PM Compass 8.4 CU 02 Deltek Cobra 8.5 Integration for PM Compass 
8.4_8.5.0703.3448 

PM Compass 8.4 CU 01 Deltek Cobra 8.5 Integration for PM Compass 
8.4_8.5.0702.3430 

If you have upgraded from Cobra 8.4 to 8.5 and are using PM Compass 8.4 CU 04, you should note that 
no new integration file was released at the same time as PM Compass 8.4 CU 04. However, there was an 
integration file released prior to it, which is Deltek Cobra 8.5 Integration for PM Compass 
8.4_8.5.0704.3469. To ensure that PM Compass integration with Cobra works correctly, you must install 
this version on your PM Compass Process server. 

https://help.deltek.com/Product/Cobra/8.4/GA
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Attention: For more information on the PM Compass Cumulative Updates and Integration Releases, 
download the related document from the Deltek Support Center site. If you have any questions, 
contact a Deltek Customer Success analyst. 

https://support.deltek.com/
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New Features and Enhancements 
This section includes summaries of the new features and enhancements included for this release. 

Extend the Number of Codes Defined in a Project 
To provide more flexibility in using codes for reporting, Cobra now allows you to define a maximum of 20 
control account codes and 20 work package codes (from previously 9 codes). 

 
Fields Tab of the Project Properties Dialog Box 

This feature is implemented in the following areas of Cobra: 

Fields Tab of the Project Properties Dialog Box 
 You can define a maximum of 20 codes on the Control Account Codes tab. 

 You can define a maximum of 20 codes on the Work Package Codes tab. 

Fields Page of the New Project Wizard 
 You can define a maximum of 20 codes on the Control Account Codes tab. 

 You can define a maximum of 20 codes on the Work Package Codes tab. 
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Project View 
 You can insert a maximum of 20 control account code columns in the Spreadsheet pane and on 

the Codes tab. 

 You can insert a maximum of 20 work package code columns in the Spreadsheet pane and on 
the Codes tab. 

 The same implementation and validation for Control Account (CA) and Work Package (WP) 
Codes 1 to 20 apply when: 

 Sorting and filtering the Spreadsheet pane 

 Editing the Spreadsheet pane or the Codes tab 

 Loading and saving a view 

 Using the Find function in the Spreadsheet pane 

Add Control Account Dialog Box 
 The Control Account code assignments grid displays a maximum of 20 control account codes that 

you define on the Fields tab of the Project Properties dialog box.   

Add Work Package Dialog Box 
 The Work Package code assignments grid displays a maximum of 20 work package codes that 

you define on the Fields tab of the Project Properties dialog box.   

Copy, Move, and Rename Control Account or Work Package 
Cobra now supports control account and work package codes 1 to 20 when moving, copying, or renaming 
control accounts or work packages. 

Saving a Project 
The Save As dialog box now supports saving a new project that contained a maximum of 20 control 
account codes and 20 work package codes. The same implementation applies when you select the Copy 
Project Data option on the dialog box. 

Process Wizards 
The Criteria page or the Criteria Selection page of the following process wizards now supports control 
account and work package codes 1 to 20 in the Criteria field: 

 Reclass 

 Respread 

 Recalc 

 Replan 

 Top Down Planning 

 Update Codes 
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wInsight Wizard 
The following pages of the wInsight wizard have been updated to support control account codes and work 
package codes 1 to 20: 

 Export Structures page 

 Link Structures page 

 Control Account Codes page 

 Work Package Codes page 

Changes to the XML Output File  

During the wInsight Export process, the control account (CA) and work package (WP) codes in Cobra are 
exported to the Elements table in the wInsight database. 

In Cobra 8.3, CA Codes 1 to 9 are exported to the C1 to C9 columns in the Elements table of the wInsight 
database, while WP Codes 1 to 9 are exported to the C10 to C18 columns after the wInsight Export 
process. 
With Cobra now supporting up to 20 control account codes and 20 work package codes in 8.4, the same 
WP Codes 1 to 9 are also exported to the C1 to C9 columns in the Elements table of the wInsight 
database. 

In the XML output file, the columns information is exported to the <Columns> section. CA Code 1 and WP 
Code 1 are now placed in C1, CA Code 2 and WP Code 2 are now stored in C2, and so on.  
<Columns> 

<Column id="col1"> 

<TableID>4</TableID> 

<ColName>C1</ColName> 

<DataType>5</DataType> 

<Length>59</Length> 

<SQL>Element.C1</SQL> 

<Alias>C1</Alias> 

</Column> 

</Columns> 

 

Example 

Project: Demo Advanced  

 Control Account Code Field 1 is a code validated field assigned with the Location code file. 

 Work Package Code Field 1 is a code validated field assigned with the Charge Number code file. 

Note: Control account codes and work package codes 1 to 20 are also supported when you 
run the Recalc, Respread, Reclass, or Replan process through the API and the Cobra Web 
Service. 

Attention: See the “Columns Section of the XML File” topic in the Cobra Help System. 

https://help.deltek.com/Product/Cobra/8.4/GA/Columns%20Section%20of%20the%20XML%20File.html
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Cost Data Wizard 
The following pages of the Cost Data wizard have been updated to support control account codes and 
work package codes 1 to 20 when generating the Deltek Common Data Exchange (DCDE) file or the 
Integrated Program Management Data Analysis Report (IPMDAR) file: 

 Export Structures page 

 Codes and Structures page 

 

Note: To support IPMDAR's ability to have 10 custom codes on the control account and work 
package respectively, you can map any of the 20 Cobra codes to the IPMDAR file. 
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Integration Wizard 
Cobra now supports importing of control account codes and work package codes 1 to 20 when loading 
data from an import file, Open Plan, Microsoft Project, and Primavera. 

Analyze Utility 
Cobra now supports control account codes and work package codes 1 to 20 for project analysis. 

SQL Command Utility 
The SQL Command Utility now supports control account codes and work package codes 1 to 20 when 
using the %c parameter. 

Backup and Restore 
Cobra now supports backup and restore of the following files which contain control account codes and 
work package codes 1 to 20:  

 Projects 

 Reports and Templates 

 Sorts and Filters 

 Configurations 

Reports 
Cobra now supports control account codes and work package codes 1 to 20 as report criteria in the 
following areas: 

 Sub-Totals page of the Report wizard 

 New Filter Expression dialog box of the Report wizard 

 The {CriteriaN.CodeAsg[N]} report tag 

Cobra Web Service 
Cobra now supports control account codes and work package codes 1 to 20 through the Cobra Web 
Service. 

Support for a New Forecast Method 
You can now create a single forecast class that uses different forecast methods based on codes or 
progress techniques using the Coded Ranges method. 

The new Coded Ranges Forecast method allows users to create a single forecast class that uses multiple 
methods. This is done by allowing the user to select control account codes, work package codes, or 
project technique, and assigning a method to each value. When Cobra calculates a forecast using the 

Attention: See the “Codes and Structures Page of the Cost Data Wizard” topic in the Cobra Help 
System. 

https://help.deltek.com/Product/Cobra/8.4/GA/Codes%20and%20Structures%20Page%20of%20the%20Cost%20Data%20Wizard.html
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Coded Ranges method, it will apply the selected method based on the coding. The end result is that 
users are able to reduce processing time and data size by using one class. 

The new forecast method is added to the Forecast Method field on the Forecast Class page of the New 
Class wizard. Selecting Coded Ranges displays the Coded Ranges pane, where you can select a code 
from the list of saved control account codes, work package codes, or progress techniques using the Code 
Field drop-down list. Populate the Coded Ranges grid by assigning up to three values from the selected 
code or three progress techniques. And then, map each assigned code value to an existing forecast 
method (except for Frozen Forecast, Percent Complete Ranges, PF=User Input, and None.) Also, assign 
an existing forecast method to the Other row. Control accounts and work packages that are not assigned 
one of the values on the first three rows will use the technique assigned to Other. 

 
Forecast Class Page the New Class Wizard  

 
When you select the forecast class that uses the Coded Ranges forecast method on the Classes tab of 
the Project Properties dialog box, the Coded Ranges pane is displayed on the General tab pane below, 
where you can update the Code Field, Code Value, and the forecast method for each code. 

Attention: See the “Forecast Class Page of the New Class Wizard” topic in the Cobra Help System. 

https://help.deltek.com/Product/Cobra/8.4/GA/Forecast%20Class%20Page%20of%20the%20New%20Class%20Wizard.html
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General Tab of the Classes Tab of the Project Properties Dialog Box 

 
When using the Copy Classes function on forecast classes that use Coded Ranges forecast method, the 
control account and/or work package code fields must be configured similarly on the target project.  

 
The same implementation applies when you run the Calculate Forecast process through the application, 
the API, and the Cobra Web Service, or when you perform save, backup, or restore on projects with 
forecast classes that use the Coded Ranges forecast method. 

Cobra Web Service Enhancements 
The Cobra Web Service now supports the following processes: 

 Deletion of a project, including its calendar  

 

Attention: See the “General Tab of the Classes Tab” topic in the Cobra Help System. 

Attention: See the “Copy Classes”, “Coded Ranges”, and “Forecast Details Pane” topics in the 
Cobra Help System. 

Note: When you delete or rename a project, Cobra does not delete or rename the process 
logs associated with it. 

http://help.deltek.com/Product/Cobra/8.4/GA/api/html/T_Cobra_Model_WebService_DeleteProjectServiceArguments.htm
https://help.deltek.com/Product/Cobra/8.4/GA/General%20Tab%20of%20the%20Classes%20Tab.html
https://help.deltek.com/Product/Cobra/8.4/GA/Copy%20Classes.html
https://help.deltek.com/Product/Cobra/8.4/GA/Coded%20Ranges%20Method.html
https://help.deltek.com/Product/Cobra/8.4/GA/Forecast%20Details%20Pane.html


New Features and Enhancements 

Release Notes 10 

 

 Deletion of a single or multiple resource assignments  

 Deletion of work packages or multiple work packages  

In addition, the deletion of work package process has a setting that allows you to run the update 
totals process on the control account to which the work package belongs after its deletion. By 
default, the update totals process is not ran after a work package deletion. 

 Replan (which is also supported through the API) 

 

 

Ability to Secure the Delete Milestones No Longer in the 
Schedule Option 
The Change Control page of the Integration wizard’s Delete milestones no longer in the schedule 
option is added to the Integration Wizard Preferences tab of the Project Properties dialog box to allow you 
to secure this option at the project level. 

 
Change Control Page of the Integration Wizard 

Attention: See the “Supported Processes and Data” and “Replan Process” topics in the Cobra Help 
System. 

Attention: To display the Web Service Client API Help, click the following link: Web Services Client 
API. You can also navigate to the \Help\API subfolder of your Cobra installation folder. 

http://help.deltek.com/Product/Cobra/8.4/GA/api/html/T_Cobra_Model_WebService_DeleteResourceAssignmentServiceArguments.htm
http://help.deltek.com/Product/Cobra/8.4/GA/api/html/Properties_T_Cobra_Model_WebService_DeleteWorkPackageServiceArguments.htm
http://help.deltek.com/Product/Cobra/8.4/GA/api/html/T_Cobra_Model_WebService_ReplanServiceArguments.htm
https://help.deltek.com/Product/Cobra/8.4/GA/Replan%20Process.html
https://help.deltek.com/Product/Cobra/8.4/GA/Supported%20Processes.html
https://help.deltek.com/Product/Cobra/8.4/GA/Replan%20Process.html
http://help.deltek.com/Product/Cobra/8.4/GA/api/html/R_Project_Web_Service_ClientAPI.htm
http://help.deltek.com/Product/Cobra/8.4/GA/api/html/R_Project_Web_Service_ClientAPI.htm
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Integration Wizard Preferences Tab of the Project Properties Dialog Box 

In EPM Security Administrator, the option is added a child node of Delete items from Cobra that are no 
longer in the schedule in Projects » Project Properties » Preferences tab » Integration Wizard. By 
default, this option is set to Enabled/Visible. 
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EPM Security Administrator 

The following table describes the behavior of this option. 

Integration Wizard Preferences Tab Change Control Page of the Integration Wizard 

Selected Secure New Configuration Existing Configuration 

 X  |Enabled Follows the selection in 
the configuration file 

   |Disabled Follows the selection on 
Integration Wizard 
Preferences tab 

X X X |Enabled Follows the selection on 
Integration Wizard 
Preferences tab 

X  X |Disabled Follows the selection in 
the configuration file 

 [] indicates that the check box is selected. 

 [X] indicates that the check box is cleared. 

 Enabled means you can still select or clear the check box. 

 Disabled means you can no longer select or clear the check box. 
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Ability to Load Forecasts in the Current Status Period During 
Integration 
Previously, Cobra did not allow you to load forecasts into the current status period during integration. To 
help the Cost Account Managers to plan out the entire estimate to complete (ETC) prior to loading actuals 
and calculating forecast, the Allow loading forecast in the current status period option is added to the 
Project Properties dialog box and the Resource Assignments page of the Integration Wizard. With both 
the Allow loading forecast in the current status period and the Apply historical forecast changes 
as an adjusting entry in the current status period options on the Integration Wizard Preferences tab of 
Project Properties dialog box selected, Cobra will now adjust the entries in the current period rather than 
in the period after the status period. 

 
Resource Assignments Page of the Integration Wizard 

Attention: See the “Change Control Page of the Integration Wizard,” “Integration Wizard Preferences 
Tab of the Project Properties Dialog Box,” and “Behavior of the Options” topics in the Cobra Help 
System. 

https://help.deltek.com/Product/Cobra/8.4/GA/Change%20Control%20Page%20of%20the%20Integration%20Wizard%20Scheduling%20Tools.html
https://help.deltek.com/Product/Cobra/8.4/GA/Integration%20Wizard%20Preferences.html
https://help.deltek.com/Product/Cobra/8.4/GA/Integration%20Wizard%20Preferences.html
https://help.deltek.com/Product/Cobra/8.4/GA/Behavior%20of%20the%20Options.html
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Integration Wizard Preferences Tab of the Project Properties Dialog Box 

The following example shows how entries are adjusted with different combinations of the Apply 
historical forecast changes as an adjusting entry in the current status and the Allow loading 
forecast in the current status period options. 

 
In EPM Security Administrator, the Allow loading forecast in the current status period option is added 
to Projects » Project Properties » Preferences tab » Integration Wizard. By default, this option is set 
to Enabled/Visible. 
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EPM Security Administrator 

The following table describes the behavior of this option. 

Integration Wizard Preferences Tab Resource Assignments Page of the Integration 
Wizard 

Selected Secure New Configuration Existing Configuration 

 X  |Enabled Follows the selection in 
the configuration file 

   |Disabled Follows the selection on 
Integration Wizard 
Preferences tab 

X X X |Enabled Follows the selection on 
Integration Wizard 
Preferences tab 

X  X |Disabled Follows the selection in 
the configuration file 

 [] indicates that the check box is selected. 

 [X] indicates that the check box is cleared. 

 Enabled means you can still select or clear the check box. 

 Disabled means you can no longer select or clear the check box. 
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Ability to Include Multiple Projects on a Single Report 
You can now run the Report wizard against multiple projects (without first setting up a master project) to 
include on a single report. 

The Include multiple projects on report check box is added to the Report page. 

 
Report Page of the Report Wizard 

 
Selecting the Include multiple projects on report check box and then clicking Next on the Report page 
displays the Projects Selection page, where you can select additional projects to include on the report. 

Attention: See the “Resource Assignments Page of the Integration Wizard,” “Integration Wizard 
Preferences Tab of the Project Properties Dialog Box,” and “Behavior of the Options” topics in the 
Cobra Help System. 

Attention: See the “Report Page of the Report Wizard” and “Report Types” topics in the Cobra Help 
System. 

https://help.deltek.com/Product/Cobra/8.4/GA/Resource%20Assignments%20Page%20of%20the%20Integration%20Wizard%20Text%20Files.html
https://help.deltek.com/Product/Cobra/8.4/GA/Integration%20Wizard%20Preferences.html
https://help.deltek.com/Product/Cobra/8.4/GA/Integration%20Wizard%20Preferences.html
https://help.deltek.com/Product/Cobra/8.4/GA/Behavior%20of%20the%20Options.html
https://help.deltek.com/Product/Cobra/8.4/GA/Report%20Page%20of%20the%20Report%20Wizard.html
https://help.deltek.com/Product/Cobra/8.4/GA/Report%20Types.html
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Projects Selection Page of the Report Wizard 

 
On the Sub-Totals page, Project is added as an additional criteria under Project Structure. Selecting 
Project includes the project-level totals for each of the selected projects on the generated report. 

 
Sub-Totals Page of the Report Wizard 

 

Attention: See the “Projects Selection Page of the Report Wizard” topic in the Cobra Help System. 

Attention: See the “Sub-Totals Page of the Report Wizard” topic in the Cobra Help System. 

https://help.deltek.com/Product/Cobra/8.4/GA/Projects%20Selection%20Page%20of%20the%20Report%20Wizard.html
https://help.deltek.com/Product/Cobra/8.4/GA/Sub%20Totals%20Page%20of%20the%20Report%20Wizard.html
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On the Cost Sets page, all cost sets from the selected projects are displayed. Select which cost sets to 
include on the generated report. 

 
Cost Sets Page of the Report Wizard 

 

 
The following example is a Time-phased report which shows project-level totals for each of the selected 
projects. 

 
This feature is also supported in the Cobra Web Service. 

Attention: See the “Cost Sets Page of the Report Wizard” topic in the Cobra Help System. 

Note: The Rates worksheet of the generated report will only contain rate sets from the rate files used 
with the default project. See the “Report Content Parameters” topic in the Cobra Help System. 

http://help.deltek.com/Product/Cobra/8.4/GA/api/html/T_Cobra_Model_WebService_ReportServiceArguments.htm
https://help.deltek.com/Product/Cobra/8.4/GA/Cost%20Sets%20Page%20of%20the%20Report%20Wizard.html
https://help.deltek.com/Product/Cobra/8.4/GA/Report%20Content%20Parameters.html
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Ability to Include Control Accounts and Work Packages with 
No Time-Phased Data on Reports 
The Include Control Accounts/Work Packages with no data check box is added to the Sub-Totals 
page of the Report wizard. By selecting this check box, you can now include control accounts and work 
packages that do not contain time-phased data for the selected cost sets on the generated report.  

 
Sub-Totals Page of the Report Wizards 

This check box is enabled if:  

 The selected report on the Report page is a CrossTab report.  

 Control Account or Work Package is selected as Criteria. 

 

Ability to Store Decimals on Milestone Weight  
Cobra now stores milestone weight values with six decimal places. The Precision of Milestone Weight 
field is added to the General tab of the Application Preferences dialog box. Using this field, you can 
display the milestone weight value on Milestones/Steps tab of the Project view with up to six decimal 
places. 

Attention: See the “Sub-Totals Page of the Report Wizard” topic in the Cobra Help System. 

https://help.deltek.com/Product/Cobra/8.4/GA/Sub%20Totals%20Page%20of%20the%20Report%20Wizard.html
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General Tab of the Application Preferences Dialog Box 

When integrating data from an import file or any scheduling tools (Primavera, Open, Plan, and Microsoft 
Project), Cobra now imports milestone weight value with six decimal places regardless of the value 
specified in the Precision of Milestone Weight field.  

 

Ability to Not Concatenate the Control Account ID to the 
Work Package ID When Exporting the IPMDAR File 
The Do not prefix Work Package ID with Control Account ID option is added in the Cost Data pane of 
the Integration tab of the Application Preferences dialog box. This option allows you to enable or disable 
concatenation of Control Account (CA) key fields and the Work Package (WP) ID when creating the 
Integrated Program Management Data Analysis Report (IPMDAR) file during the Cost Data Export 
process. 

Attention: See the “General Tab of the Application Preferences Dialog Box” and “Milestones/Steps 
Tab of the Project View” topics in the Cobra Help System. 

https://help.deltek.com/Product/Cobra/8.4/GA/General%20Tab%20of%20the%20Application%20Preferences%20Dialog%20Box.html
https://help.deltek.com/Product/Cobra/8.4/GA/Milestones%20Steps%20Tab%20of%20the%20Project%20View.html
https://help.deltek.com/Product/Cobra/8.4/GA/Milestones%20Steps%20Tab%20of%20the%20Project%20View.html
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Integration Tab of the Application Preferences Dialog Box 

If this option is cleared, which is the default value, Cobra performs concatenation of the Control Account 
key field value and the Work Package ID value to obtain the new Work Package ID value. After 
completing the Cost Data Export process, the Work Package ID value in the generated IPMDAR file is 
displayed as Control Account ID + Work Package ID. 

If this option is selected, Cobra does not perform concatenation of the Control Account and Work 
Package IDs during the Cost Data Export process. 

 

Support for XLSM File Extension 
Cobra now supports the Excel Macro-Enabled Workbook (*.xlsm) file extension as an output type when 
generating reports. 

You can select Excel Macro-Enabled Workbook (*.xlsm) as an output type in the following areas of 
Cobra: 

 Locate Custom Application dialog box which displays when you click the Report Template field 
on the Style page of the Report wizard 

Attention: See the “Integration Tab of the Application Preferences Dialog Box” and “Cost Data 
Export” topics in the Cobra Help System. 

https://help.deltek.com/Product/Cobra/8.4/GA/Integration%20Tab%20of%20the%20Application%20Preferences%20Dialog%20Box.html
https://help.deltek.com/Product/Cobra/8.4/GA/Cost%20Data%20Export%20to%20Acumen.html
https://help.deltek.com/Product/Cobra/8.4/GA/Cost%20Data%20Export%20to%20Acumen.html
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 General tab of the Add Batch Report or Edit Batch Report dialog box 

 

 

De-Support XLS File Extension 
Cobra no longer supports the .xls file extension. When you run a report that uses the .xls extension on the 
report template using the Report wizard, Cobra generates the report in .xlsx format. When you run or 
restore a batch report that uses the .xls extension, Cobra converts the output to .xlsx format. 

In addition, the Reports tab on the User Preferences dialog box has been removed. 

Attention: See the “General Tab of the Add Batch Report Dialog Box” and “General Tab of the Edit 
Batch Report Dialog Box” topics in the Cobra Help System. 

https://help.deltek.com/Product/Cobra/8.4/GA/General%20Tab%20of%20the%20Add%20Batch%20Report%20Dialog%20Box.html
https://help.deltek.com/Product/Cobra/8.4/GA/General%20Tab%20of%20the%20Edit%20Batch%20Report%20Dialog%20Box.html
https://help.deltek.com/Product/Cobra/8.4/GA/General%20Tab%20of%20the%20Edit%20Batch%20Report%20Dialog%20Box.html
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User Preferences Dialog Box 

Reclass Process Update for Not Included in Budget Classes  
Cobra now allows you to select a non-included budget classes as a Source class when you run the 
Reclass wizard. The not included in budget classes now ignore the Project Preferences’ Allow changes 
to scope of in-progress Control Account/Work Package option selection for the selected project. 

 

Update Totals Run Only Against Impacted Control Accounts 
and Work Packages 
During the integration of data from an import file or any scheduling tool (Primavera, Open, Plan, or 
Microsoft Project), Cobra now runs the Updates Totals process only for the control accounts/work 
packages where values are loaded into when Total Project is selected in the Criteria field on the Filter 
page of the Integration Wizard. 

When the Delete Control Accounts and Work Packages no longer in the schedule option on the 
Change Control page of the Integration Wizard is selected, only the budget totals will be updated for the 
control accounts whose work packages were deleted. 

 

Modified Budget Tab of the Project Properties Dialog Box 
The Budget tab of the Project Properties dialog box has been modified to display a grid with the Total 
Budget and Total Estimate at Complete columns. 

Attention: See the “Project Preferences” topic in the Cobra Help System. 

Attention: See the “Change Control Page of the Integration Wizard” and “Filter Page of the 
Integration Wizard” topics in the Cobra Help System. 

https://help.deltek.com/Product/Cobra/8.4/GA/Project%20Preferences.html
https://help.deltek.com/Product/Cobra/8.4/GA/Change%20Control%20Page%20of%20the%20Integration%20Wizard%20Scheduling%20Tools.html
https://help.deltek.com/Product/Cobra/8.4/GA/Filter%20Page%20of%20the%20Integration%20Wizard.html
https://help.deltek.com/Product/Cobra/8.4/GA/Filter%20Page%20of%20the%20Integration%20Wizard.html
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Budget Tab of the Project Properties Dialog Box 

Support for New Technologies 
Cobra 8.4 supports the following technologies and Deltek products. 

Supported Deployment Technology 

Database Platform  Microsoft SQL Server 2019  

 Microsoft SQL Server Express 2019 

Primavera  Primavera 19.12 

Deltek Integrated Products  PM Compass 8.2 (When PM Compass 8.2 is 
released, check the PM Compass 8.2 
Compatibility Matrix) 

 Open Plan 8.5 

 Acumen 8.7 

 EPM Security Administrator 8.4 

 

Attention: See the “Software Requirements” section in the Deltek Cobra 8.4 Installation Guide for the 
complete list of supported and compatible technologies. 
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Software Issues Resolved 

API 

Defect 1269641  
Description: When you ran the Reclass, Respread, or Recalc process through the API, the values you 
specified in the Criteria and Selection settings were not validated correctly. 

Customers Impacted: This defect affects customers who run the Reclass, Respread, or Recalc process 
through the API. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.Api.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

Defect 1411475 
Description: You could generate reports through the API and the Web Service even if you did not have 
read access to the project or ancillary files. 

Customers Impacted: This defect affects customers who use the API and the Web Service to generate 
reports 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

 Cobra.ReportLayoutEngine.dll 

 Cobra.WebService.Host.exe 

 Cobra.Api.exe 

API » Web Services 

Defect 1383713  
Description: The validation error message displayed for pending dates when adding a new control 
account or a new work package using the Cobra Web Service was not appropriate. 

Customers Impacted: This defect affects customers who use the Cobra Web Service. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 
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 Cobra.WebService.dll 

 Cobra.WebService.Host.exe 

Defect 1384218  
Description: When you added a new control account or a work package using the Cobra Web Service 
and the control account key fields were blank, an unhandled exception error was displayed instead of an 
error message. 

Customers Impacted: This defect affects customers who use the Cobra Web Service. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

 Cobra.WebService.dll 

 Cobra.WebService.Host.exe 

Defect 1345469  
Description: When you deleted a work package through the Cobra application, the control account level 
totals and project level totals were not updated. 

Customers Impacted: This defect affects customers who use the delete work package function. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

 Cobra.WinUI.exe 

 Cobra.WinUI.*.dll 

Defect 1333426  
Description: When you ran the Recalculate or Respread process through the Cobra Web Service and 
defined the Criteria and Selection settings to set the portion of the project to recalculate or respread, the 
Cobra Web Service ran the process on the entire project. 

Customers Impacted: This defect affects customers who use the Cobra Web Service. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WebService.dll 

 Cobra.WebService.Host.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

 Cobra.Model.WebService.dll 
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Defect 1344022 
Description: When you ran the Reclass process through the Cobra Web Service, the 
CopyResourceAssignmentCode setting always defaulted to Source even if you set it to Target. 
Customers Impacted: This defect affects customers who use the Cobra Web Service. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WebService.ClientAPI.dll 

Defect 1344036 
Description: When you ran the Reclass process through the Cobra Web Service, codes with User Field 
and Text code field types were not correctly reclassified because the IncludeChildren setting for these 
types defaulted to True. 

Customers Impacted: This defect affects customers who use the Cobra Web Service. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.WebService.dll 

 Cobra.WebService.Host.exe 

Defect 1409588 
Description: The project's batch number did not increment when you performed the following actions 
through the Cobra Web Service: 

 Create a control account 

 Create a work package 

Customers Impacted: This defect affects customers who use the Cobra Web Service. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

 Cobra.WebService.Host.exe 
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File » Integration Cost Data Export 

Defect 1251883 
Description: When you ran the Cost Data wizard, opened a read-only configuration file, and then 
selected a different configuration file to which you have read-write permission, the fields and options on 
each wizard page were still disabled. 

Customers Impacted: This defect affects customers who use the Cost Data wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

Defect 1338925 
Description: When you ran the Cost Data Export wizard to generate the Integrated Program 
Management Data Analysis Report (IPMDAR) file and there were unassigned control accounts codes or 
work package codes, the Control Account/Work Package Custom Field Values files of the generated 
JavaScript Object Notation (JSON) files still contained entries for the unassigned codes. 

Customers Impacted: This defect affects customers who use the Cost Data wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

 PPM.CommonData 

File » Integration wInsight 

Defect 1372051  
Description: When you exported data to wInsight XML format and any of the exported control account or 
work package code assignments contained a NULL value, Cobra displayed an error message. 

Customers Impacted: This defect affects customers who export data to wInsight. 

Workaround Before Fix: Replace the NULL values in the C1 - C9 fields in the CAWP database table 
with ' '. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 
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File » Integration Wizard — Project Data 

Defect 1377531 
Description: When you ran the Integration Wizard to load forecast data, Cobra did not include the 
actuals in the EAC total calculation when the update totals process was ran during integration. 

Customers Impacted: This defect affects customers who use the Integration Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.Process.dll 

 Cobra.WinUI.exe 

 Cobra.WinUI.*.dll 

Defect 1348488  
Description: When you ran the Integration Wizard to load code assignments and user fields, Cobra 
encountered the "Error filling cursor for BDNDETL: There is not enough memory to complete this 
operation" error if the project's CAM field has a code file specified and there were no code files assigned 
to any of the control account or work package level codes. 

Customers Impacted: This defect affects customers who use the Integration Wizard. 

Workaround Before Fix: Assign a code file to the control account or work package codes. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Defect 1378201 
Description: When you ran the Integration Wizard to load resource assignment percent complete values 
and assigned a file in the Status File field, you encountered the "Error LINKSTSR" message if the status 
file contained no records. 

Customers Impacted: This defect affects customers who perform a single-project integration using the 
Integration Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.Process.dll 

 Cobra.WinUI.exe 

 Cobra.WinUI.*.dll 

Defect 1368427 
Description: When you used the multi-project concurrency feature, you encountered the "Invalid Status 
File" error if the account you used to run the Cobra Web Service did not have access to the files specified 
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on the Project Selection page of the Integration Wizard and the project that existed in the activity file was 
not included in the status file. 

Customers Impacted: This defect affects customers who use the multi-project concurrency feature. 

Workaround Before Fix: Update the status file and make sure that all projects included in the activity file 
exist. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

Defect 1378710 
Description: When you ran the Integration Wizard, the control account code field was updated with work 
package codes if the control account codes and the work package codes shared the same column in the 
scheduling tool. 

Customers Impacted: This defect affects customers who use the Integration Wizard. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.Process.dll 

 Cobra.WinUI.exe 

 Cobra.WinUI.*.dll 

Framework 

Defect 1390274  
Description: When you clicked Finish on a Cobra wizard and a validation error was encountered on 
another wizard page, Cobra redirected you to the wizard page with the validation error but the wizard 
page displayed an incorrect title bar and description. 

Customers Impacted: This defect affects all customers who use the following wizards: 

 Calculate Forecast Wizard 

 Calculate Progress Wizard 

 New Code File Wizard 

 New Rate File Wizard 

 Recalc Wizard 

 Report Wizard 

 Zero-Out Data Wizard 

Workaround Before Fix: None. 

Files Updated: 
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 Cobra.WInUI.*.dll 

 Cobra.WinUI.exe 

Defect 1246362  
Description: When you added the CAM column on the Resource Assignment Lookup dialog box and 
then expanded a control account, the resource assignment rows under the control account displayed a 
CAM value. 

Customers Impacted: This defect affects customers who use the Resource Assignment Lookup dialog 
box. 

Workaround Before Fix: Expand the control account before adding the CAM column. 

Files Updated: 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

Help 

Defect 1263086  
Description: When you selected or cleared the Automatically send usage statistics to Deltek option 
on the About Deltek dialog box and you had insufficient access to update the IdeaBlade.IbConfig file, 
Cobra displayed an error message with no recommendations on how to resolve the issue. 

Customers Impacted: This defect affects all customers who access the About Deltek dialog box with 
insufficient access to update the IdeaBlade.IbConfig file. 

Workaround Before Fix: None. 

Additional Notes: This issue is also encountered on the Change Password dialog box of the Data Tool. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 ConfigManager.dll 

 DataTool.exe 

Project Processes » Analyze 

Defect 1355621  
Description: When you ran the Analyze process on Control Account Field 9, Cobra encountered the 
“Error in processing analyze data" error message. 

Customers Impacted: This defect affects customers who use the Analyze process. 

Workaround Before Fix: None. 
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Files Updated: 

 Cobra.Process.dll 

 Cobra.WinUI.exe 

 Cobra.WinUI.*.dll 

Projects 

Defect 1335291  
Description: If you did not have rights to delete calendar files and you deleted a project and its 
associated calendar, Cobra deleted both the project and the calendar. 

Customers Impacted: This defect affects customers who use the delete project function. 

Workaround Before Fix: None. 

Additional Notes: This issue is also encountered when you delete a project through the API. 

Files Updated: 

 Cobra.WinUI.exe 

 Cobra.WinUI.*.dll 

Defect 1336125  
Description: When you deleted a project which included a calendar shared with two or more projects, 
Cobra did not delete the project and displayed an error about deleting the shared calendar. Cobra should 
display a warning message informing you that the calendar is shared with another project and then allow 
you to delete the project but not the shared calendar. 

Customers Impacted: This defect affects customers who use the delete project function. 

Workaround Before Fix: None. 

Additional Notes: This issue is also encountered when you delete a project through the API. 

Files Updated: 

 Cobra.WinUI.exe 

 Cobra.WinUI.*.dll 

Projects » Project Information 

Defect 1357173  
Description: When you created a forecast class using the New Class wizard with the Performance 
Factor Level and Code File fields populated, and then changed the Performance Factor Level to 
Project, Control Account, or Work Package before saving the forecast class, the Code File value was 
saved with the forecast class.  

Customers Impacted: This defect affects customers who use the New Class wizard. 

Workaround Before Fix: On the Forecast Class of the New Class wizard, clear the Code File field 
before changing the Performance Factor Level to Project, Control Account, or Work Package. 

Files Updated: 
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 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

Defect 1298524  
Description: When you edited the control account codes or the work package codes grid on the Fields 
tab of the Project Properties dialog box, opened another project without saving your changes, and then 
switched back to the project you initially updated, the rows of the codes you previously updated were no 
longer displayed in the correct order. 

Customers Impacted: This defect affects customers who use the Project Properties dialog box. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

Projects » Project View 

Defect 1366992  
Description: When you moved an in-progress work package to a planned control account, the status of 
the control account was not set to in-progress. 

Customers Impacted: This defect affects customers who use the move work package function. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Process.dll 

Defect 468401 
Description: Cobra did not prevent you from editing project data while another user was running a Cobra 
process that has locked the project exclusively. 

Customers Impacted: This defect affects customers who edit data in the Project view while other users 
run a process that locks the same project. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 
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Defect 1366999  
Description: The prompt displayed when moving a work package contained {0} character. The prompt 
displayed as follows: "Work Package begins before the Control Account. Update the Control Account {0} 
dates with Work Package {0} dates?” 

Customers Impacted: This defect affects customers who use the move work package function. 

Workaround Before Fix: None. 

Files Updated: 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

Security 

Defect 1286834 
Description: When you ran Cobra in a Terminal Service or Citrix environment and your Cobra session 
did not close properly, you might encounter orphaned locks or sessions. 

Customers Impacted: This defect affects users who run Cobra in a Terminal Services or Citrix 
environment. 

Workaround Before Fix: Perform one of the following: 

 Delete the lock records manually in the database. 

 Clear the crashed connection using the EPM Security Administrator tool. 

 
1. Log into the EPMSA tool. 

2. In the Explorer pane on the left, click Cobra. 

3. Click Tools » Clear Connections. 

4. On the Clear Connections dialog box, select the crashed connection, and click Clear User. 
Additional Notes: This issue may happen when a user leaves their Terminal Service or Citrix session 
idle and it times out, or when an active user closes their Terminal Service or Citrix window instead of the 
Cobra window. In some cases, this issue may also happen when Cobra terminates unexpectedly. 

To prevent orphaned locks or sessions when running Cobra in a Terminal Services or Citrix environment, 
you can add the ALLOWMULTIPLEINSTANCES setting in your database, if you are using Cobra 8.3 or 
lower. Beginning Cobra 8.4, the ALLOWMULTIPLEINSTANCES setting is replaced with 
the_CLEAREXISTINGLOCKS setting. Refer to KB Article 97977 in the Knowledge Center on the Deltek 
Customer Care Connect site for information on how to configure the _CLEAREXISTINGLOCKS setting. 

 
Files Updated: 

Note: This step will remove the WST_ULI record and any corresponding WST_LCK records 
immediately. If you clear user connections while they are in Cobra, the next time the polling 
interval happens, it will notice that they do not have a WST_ULI record and kick the user out. 

Attention: See the “Multiple Sessions in Cobra” topic in the Cobra Help System. 

https://help.deltek.com/Product/Cobra/8.4/GA/Mutiple%20Sessions%20in%20Cobra.html
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 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

 EPM.Security.Authentication.dll 

Tools » Update Codes 

Defect 1335217  
Description: When you ran the Update Codes wizard to update a work package or a resource 
assignment code field, and you filtered by Resource with the Include all children option selected, Cobra 
encountered the "ORA-00907: missing right parenthesis" error. 

Customers Impacted: This defect affects customers who use the Update Codes process. 

Workaround Before Fix: Manually update the work package or the resource assignment code field 
values in the Spreadsheet pane of the Project view. 

Files Updated: 

 Cobra.Model.dll 

 Cobra.Model.LoginManager.dll 

 Cobra.WinUI.*.dll 

 Cobra.WinUI.exe 

Security-Related Software Issues Resolved 
Additional security fixes are included in this release. 
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EPM Security Administrator Updates 
This section includes updates to the EPM Security Administrator (EPM SA) tool for this release. 

New Features and Enhancements 
This section includes summaries of the new features and enhancements included for this release. 

Multiple Instances of EPM Security Administrator on a Shared Server 
Two or more users who are logged on to a shared server at the same time can each run EPM SA. Each 
user can only run one instance of the application. 

Software Issues Resolved 

Defect 1409483 

Description: When you tried to import a user with an empty Manager name on the Active Directory user 
account from Active Directory Services, an unhandled exception error occurred. 

Customers Impacted: This defect affects users importing users from Active Directory Services in EPM 
Security Administrator. 

Workaround Before Fix: Take one of the following actions: 

 Select a manager. 

 Do not set the property 

 Known Issues When Running a Report with Cobra Connected to an Oracle 18c or 19c Database 
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Known Issues 
This section contains information about existing issues that will be resolved in a future release. 

Issues When Running a Report with Cobra Connected to an 
Oracle 18c or 19c Database 

Description 
If you are connected to an Oracle 18c or 19c database when running a report, Cobra may generate the 
report with incomplete data or may fail to generate the report in any of the following scenarios: 

 If you run a report against a master project with only a Project Code criteria that has Code Field 
Type = Text, Cobra fails to generate the report. This scenario may affect Cobra 8.3 and Cobra 
8.4. 

 If you run a report against multiple projects with only the Project criteria, Cobra generates the 
report but possibly with incomplete data. The report output is not reliable for this criteria. This 
scenario may affect Cobra 8.4. 

 If you run a report against a master project or multiple projects with the Control Account and 
Work Package criteria, Cobra fails to generate the report. This scenario may affect Cobra 8.3 
and Cobra 8.4. 

Cause 
This issue is caused by an Oracle bug.  

Workaround/Solution 
Deltek is currently working with Oracle for a workaround and a schedule on when the issue will be fixed. 
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Database Changes  
This section includes the changes made to the database for this release. 

New Tables 
This section includes new tables and their columns. 

CLASSRANGES 

Column Name Data Type 

PROGRAM NVARCHAR(22) 

CLASS NVARCHAR(20) 

FIELDNUM INT 

RANGE_KEY NVARCHAR(59) 

RANGE_VALUE NVARCHAR(100) 

TEMP_DIR 

Column Name Data Type 

INSTANCE NVARCHAR(22) 

DIR_ID NVARCHAR(22) 

TIMESTAMP DATETIME 

Columns 
This section includes changes to table columns. 

New Columns Added 

Table Name Column Name Data Type 

CAWP C10 NVARCHAR(59) 

CAWP C11 NVARCHAR(59) 

CAWP C12 NVARCHAR(59) 

CAWP C13 NVARCHAR(59) 
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Table Name Column Name Data Type 

CAWP C14 NVARCHAR(59) 

CAWP C15 NVARCHAR(59) 

CAWP C16 NVARCHAR(59) 

CAWP C17 NVARCHAR(59) 

CAWP C18 NVARCHAR(59) 

CAWP C19 NVARCHAR(59) 

CAWP C20 NVARCHAR(59) 

CLASSES RANGE_FIELDID NVARCHAR(30) 

Modified Columns 

Table Name Column Name Data Type Update 

CAWP C1 NVARCHAR(59) Removed default 
value 

CAWP C2 NVARCHAR(59) Removed default 
value 

CAWP C3 NVARCHAR(59) Removed default 
value 

CAWP C4 NVARCHAR(59) Removed default 
value 

CAWP C5 NVARCHAR(59) Removed default 
value 

CAWP C6 NVARCHAR(59) Removed default 
value 

CAWP C7 NVARCHAR(59) Removed default 
value 

CAWP C8 NVARCHAR(59) Removed default 
value 

CAWP C9 NVARCHAR(59) Removed default 
value 

CODEFIELD FIELDID NVARCHAR(30) Updated length 
from 2 to 30 
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Table Name Column Name Data Type Update 

CODEFIELD CODELEVEL NVARCHAR(1) Made field non-
nullable 

MILESTN WEIGHT DECIMAL(21, 6) Changed from 
Int to Decimal 

NARRTEXT KEY_TYPE NVARCHAR(20) Updated length 
from 5 to 20 

PROGRAM P1 NVARCHAR(59) Removed default 
value 

PROGRAM P2 NVARCHAR(59) Removed default 
value 

PROGRAM P3 NVARCHAR(59) Removed default 
value 

PROGRAM P4 NVARCHAR(59) Removed default 
value 

PROGRAM P5 NVARCHAR(59) Removed default 
value 

PROGRAM P6 NVARCHAR(59) Removed default 
value 

PROGRAM P7 NVARCHAR(59) Removed default 
value 

PROGRAM P8 NVARCHAR(59) Removed default 
value 

PROGRAM P9 NVARCHAR(59) Removed default 
value 

Deleted Columns 

Table Name Column Name 

CODEFIELD FIELDNUM 



Database Changes 

Release Notes 41 

 

Objects 
This section includes changes to functions, stored procedures, views, indexes, and objects. 

New Indexes 

Index Name Index Fields Data Type 

IX_UNIQUE_CLASSRANGES PROGRAM, CLASS, FIELDNUM Unique 

IX_UNIQUE_CLASSRANGES_RANGEKEY PROGRAM, CLASS, 
RANGE_KEY 

Unique 

IX_UNIQUE_TEMP_DIR INSTANCE, DIR_ID Unique 

Modified Indexes 

Index Name Index Fields Data Type Update 

IX_UNIQUE_CODEFIELD DIR_ID, TABLE_TYPE, 
CODELEVEL, FIELDID 

Unique Updated indexed 
fields from 
FIELDNUM, 
TABLE_TYPE, DIR_ID 
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Appendix A: For Additional Information 

Deltek Support Center 
The Deltek Support Center is a support Web site for Deltek customers who purchase an Ongoing Support 
Plan (OSP).  

The following are some of the many options that the Deltek Support Center provides: 
 Search for product documentation, such as release notes, install guides, technical information, 

online help topics, and white papers 

 Ask questions, exchange ideas, and share knowledge with other Deltek customers through the 
Deltek Support Center Community 

 Access Cloud-specific documents and forums 

 Download the latest versions of your Deltek products 

 Search Deltek’s knowledge base 

 Submit a support case and check on its progress 

 Transfer requested files to a Customer Care analyst 

 Subscribe to Deltek communications about your products and services 

 Receive alerts of new Deltek releases and hot fixes 

 Initiate a Chat to submit a question to a Customer Care analyst online 

 

Access Deltek Support Center 

To access the Deltek Support Center:  
1. Go to https://deltek.custhelp.com. 

2. Enter your Deltek Support Center Username and Password. 

3. Click Login. 

 

Attention: For more information regarding Deltek Support Center, refer to the online help available 
from the Web site. 

Note: If you forget your username or password, you can click the Need Help? button on the login 
screen for help. 

https://deltek.custhelp.com/
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Available Documentation for this Release 
The following table lists the Deltek documentation available for this release. Except where noted, all the 
user guides and quick reference guides listed in this table are available for download from the Deltek 
Support Center. 

Document Name Description 

Deltek Cobra 8.4 Installation Guide The Installation Guide provides step-by-step 
procedures on how to install the application. It 
also provides information about the software and 
hardware requirements of the product. 

Deltek Cobra 8.4 Online Help The Deltek Cobra Help system provides 
administrators and users with screen/field-level 
documentation for all applications and functions in 
the current release. 

You can access the Online Help from the Cobra 
application 

Deltek EPM Security Administrator Online Help The help system for the EPM Security 
Administrator provides administrators with 
screen/field-level documentation for all of the 
security features of Cobra. 

You can access the Help from the EPM Security 
Administrator application. 

Deltek Cobra 8.4 Technical Overview and System 
Requirements 

The Technical Overview and System 
Requirements document serves as a guideline for 
hardware and software requirements and provides 
your firm’s IT department with information about 
the technical deployment architecture of Cobra. 

Deltek Cobra Data Structure This document provides you with the updated 
version of all WST tables used by several 
applications, such as Open Plan and Cobra. 

Deltek Cobra Essentials The intent of this guide is to help you become 
familiar with Cobra’s basic capabilities. 

Cobra Database Size Estimator This spreadsheet can be used to estimate the 
database size required to support your use of 
Cobra.  

 

 



 

 

About Deltek 
Better software means better projects. Deltek delivers software and information solutions that enable 
superior levels of project intelligence, management and collaboration. Our industry-focused expertise 
makes your projects successful and helps you achieve performance that maximizes productivity and 
revenue. www.deltek.com 

 

http://www.deltek.com/
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